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Traffic Setup & Tutorial 
Before you can schedule spots you need to complete these two steps: 

1. Enter a Traffic Director Password on the Personnel tab of the Traffic 
Settings window (System->Traffic Settings).  This password is required to 
approve orders, edit invoices, and enter adjustments to accounts. Orders must 
be approved before they will schedule. 

2. Insert Spot Breaks into your format clocks. 

For the rest of the global traffic settings see the chapter on the Traffic Settings 
window. 

To create and order an individual spot you need to complete these steps: 

1. On the Accounts window Create an account (entity you send the bill tofor 
agency spots see below). 

2. On the Tracks window create or import one or more Spots (tracks) that you 
intend to schedule for this account. 

3. On the Orders window create a new order for this account.  On the Order 
window Add at least one Item and Fill out the rest of the form completely. 

4. On the Order Item window select a Track from the list of spots shown and fill 
out the rest of the form. 

Each of these steps will be detailed in individual sections of this chapter 

Creating Spot Breaks 

Add a spot break to any format clock by clicking on the Insert Item button:  

When the Add Format Clock Item window appears, click Special, and double-click on 
Spot Break or highlight it and click OK.  Click Cancel to close the window then right-
click on the break label or log row and click Properties to set the spot break properties. 
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On the General tab select an Avail Type if you have defined avail types (see section 
under Traffic Settings Window).  Also enter the Maximum Length allowable for the 
break, and the Maximum Units allowable in the break.  Nominal Length only serves 
as the length of the break when viewed on the format clock. 

Enter a number between 1 and 5 into Fill Priority if you wish this break to be filled in that 
priority.  For example, to maximize music sweeps, you would give each break in the 
hour a different Fill Priority.  If you want beaks to be filled evenly then leave the Fill 
Priority blank. 

Fill Category is used for two functions.  

1. If Always fill completely is checked then Music 1 will schedule order items that 
are marked as Schedule as filler only until the break reaches Maximum 
Length.  If, after scheduling all filler only spots that can schedule in the break 
without format errors, the break is still shorter than Maximum Length and a Fill 
Category is selected, then Music 1 will schedule as many tracks as needed 
from this non-music category to fill the break to the required length.  (For each 
track added, Music 1 selects the longest one that will fit in order to minimize the 
total number of tracks added.)   

2. If Always fill completely is not checked, a Fill Category is selected, and there 
are at least two spots in the break, then Music 1 will insert one stager track from 
Fill Category before the last spot in the break. 

On the Time tab enter the Nominal Start Time (approximate, typical start time).  This time 
is used as the reported time and the time of play on invoices and to to calculate 
separation times between spots. 
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Creating Accounts 

 

Both regular accounts and agencies are created / edited from the Accounts window.  Click 
File->New Account or File->New Agency to create one.  You can view and edit the 
details for the account / agency currently highlighted in the list.  There is no OK button 
to save your edits.  If any changes were made to an account, then when you click to 
another account, to another window, or start to close the database, Music 1 will ask 
you if you want to save the changes made or Cancel to remain editing the account. 

Name is the name that will be used for the account everywhere in the program except on 
an invoice or statement where Billing Name is used instead.  If you leave 
Billing Name blank for an account then Name will be used on invoices and statements 
for that account.  Create a new account for each customer you will bill for advertising.  
Usually, an account places orders for only one product (see Orders, below), but not 
always.  A big-box retailer, for example, might advertise many products over time, 
though the retailer is the paying party, not the product manufacturers. 

Account Type is just a choice of one of the types you name on the Traffic Settings 
window.  Currently, this type is used only to filter accounts to print and to aggregate 
totals by account type on the Receivables Report window, below.  If the account was 
brought to you by an agency, then select the Agency here.  In that case, the agency is 
billed for invoices from this account and the agency must pay them.   The remainder of 
the fields on the Contact Information tab are for your reference only. 

On the Order Defaults tab you can enter values that will be applied to new orders created 
for the account being edited.  The meaning of these fields is explained under 
Creating Orders. 



6 

 

Creating Spots 

 
You add or import spots via the Tracks window.  When you create an account, a spot 

folder is created with the same name as the account and appears in the list of 
categories on the Tracks window.  The spot folders appear in plum colored text near 
the end of the categories list after all music and non-music categories. 

To create a spot, just select one of the spot folders and click the Add Track button.    
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Title is the name that will appear on an invoice.  The Folder is usually the main folder of 
the account that owns this spot unless it is in a packet (below).  Enter or select a 
Product 1 and / or Product 2 to prevent this spot from scheduling to close to another 
spot with the same product designation.  Enter the separation time on the Product 
window.  Products are listed on the Artists window by clicking the Products button. 

 

Select one of the ten possible announcers for Announcer if you want to prevent this spot 
from scheduling too close to another spot by the same announcer.  You can edit 
announcer names and separation times via the Formats window. 

For Quality, select one of the five production quality levels you can name on the 
Traffic Settings window.  Music 1 will position spots in a break in the order of longest 
to shortest, then higher quality to lower quality.  (That is, a longer spot will always be 
positioned before a shorter one, regardless of quality, but a higher quality spot will be 
positioned before a lower quality one if the higher quality spot is not shorter than the 
lower quality one.) 

Just as for music and non-music tracks, Cart contains the track identifier that is put into 
the automation log and File contains the path to the audio file for playback within 
Music 1. 

Copy and Notes are fields that you can print on the music / traffic log.  If a spot is for live 
read then leave Cart and File blank and enter the copy into Copy. 
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Spot Packets 

To create a spot packet, click Category->New->Commercial. 

 

This menu item brings up the Create Spot Folder window. 

 

If you select an Account and enter a Name, then a spot packet of that name will be added 
to the main folder of that account.  Spot Packets have two uses: 

1. To play two or more spots in equal rotation.  

2. To play two or three spots at once in the same break. 

See the Order Item window, below, for details on these. 
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Creating Orders 

The Orders window lets you view, create, clone and delete orders and order templates.   

 
Click File->Create New Order to bring up the Create Order window.  Select an account 

and click Create Order to create a 
new, blank order from that account. 

The Order form has many fields, not all of 
which are required by every order.  
To simplify order entry, Some fields 
are filled in with defaults either from 
the account’s Order Defaults tab or 
from the Billing Defaults tab of the Traffic Settings window, and Music 1 will 
highlight in blue the fields still requiring data when you attempt to save the order. 

 

Product is the thing being advertised; often, though not always the same as the 
account name which is shown in the title bar of the window. 

Start Date, End Date  Every order must have these dates.  Start Date cannot be 
changed after spots have been scheduled from the order.  The End Date may be 
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changed after spots have been scheduled from the order–though it cannot be set 
to a date before the date of the last log that those spots were scheduled. 

Revenue Type is used to allow payment by trade / barter, or require cash equivalent 
only. If you set this field to Trade, you can set the maximum value of trade you will 
accept as payment for any invoice from this order with the Trade Credit field 
(either as a percent of the invoice total, or as a fixed value).  If you set this field to 
Cash, you can pay invoices for this order only with Cash (Which includes all cash 
equivalents). 

Bill Type is required only for an order from an account that is represented by an 
agency–in which case it can be set to Gross or Net.  Orders from an account not 
represented by an agency are always billed Gross.  See the chapter on billing for 
a detailed explanation of the difference between gross and net billing. 

Billing Period sets the frequency that invoices are automatically generated.  You can 
request an invoice at any time, however. 

Account Rep defaults to the rep setting in the account’s Order Defaults tab.  This field 
is needed only if you have a rep to whom you want to pay sales commissions.  In 
that case you can enter the commission rate into Rep Commission, which is also 
set to the default on the Billing Defaults tab of the Traffic Settings window. 

Billing Basis tells Music 1 how to compute the charge for the plays over one invoice 
period.  The associated fields that appear depend on the basis type selected: 

Charge Per Broadcast For each item in the order, Music 1 applies the charge 
entered on the Elements tab of the 
Order Item window for each play of the 
item.  However, if you check 
Use Standard Charges then the charge 
for a play is that shown on the Standard Charges table of the Traffic Settings 
window for the type and length of the spot and in the day part in which it 
scheduled. 

Fixed Charge Per Day applies the Package Charge once each day that one or more 
spots from the order are scheduled. 

Fixed Charge Per Billing Period applies the Package Charge once per Billing 
Period. 

Charges On Specified Dates applies on each entered Date the entered Amount in 
the table. 
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Discount reduces the original (Gross) charges by the specified percent resulting in the 
Discounted Gross charges. 

Agency Commission % If the account is repped by an agency then this percent of the 
Discounted Gross becomes a payable (credit) to the agency’s account.  The 
Discounted Gross minus the commission so computed becomes the invoice Net. 

Rep Commission If the order has an account rep then this percent of the invoice Net 

becomes payable (a credit) to the rep’s account. 

Trade Credit is the maximum value of trade you will accept as payment for any invoice 
from this order when Revenue Type is set to Trade.  This maximum is either an 
absolute value (Fixed), or a percent of the Net value of the invoice (Percent).  The 
balance of the invoice, after zero or more of the allowable trade value has been 
paid, must be paid with Cash 

Interest Rate, Late Fee, Grace Period  If an invoice has an unpaid balance after 
Grace Period number of days from the End Date of the invoice then Music 1 will 
charge the Late Fee and interest which is computed using the number of days that 
have elapsed since Grace Period days after the End Date.  Thus, for a Grace 
Period of 10 days, 11 days after the End Date of the invoice there will be 1 day’s 
worth of interest due.  You can credit the late fee, credit the interest and even 
forgo future interest with adjustments, but you cannot change the Interest Rate or 
Late Fee on an order after spots have been scheduled and charges have been 
applied for the order. 

Consecutive Plays tells Music 1 how you want the spots from this order separated.  
You can specify either 

No Restriction Allows Music 1 to schedule spots from this order in any number of 
adjacent breaks or hours.  Use this for an order that has spots ordered to play in 
only a small number of hours. 

Disallow x Consecutive Breaks Prevents Music 1 from scheduling spots from this 
order in the selected number of adjacent breaks (either 2, 3, 4, or 5).  

Disallow x Consecutive Hours Prevents Music 1 from scheduling spots from this 
order in the selected number of adjacent hours (either 2, 3, 4, or 5). 

Invoice Type tells Music 1 how much detail you want on an invoice about the Order 
Items that have scheduled from this order.  If you check Affidavit then a statement 
and signature box with the signer’s name and date will print after the listing of the 
spots that played.  If there is a co-op item on the order then checking 
CoOp Affidavit will print the same at the end of each co-op account’s spot listing 
on the invoice. 

An order contains one or more Items (below).  It is the Order Item that specifies which 
spot to schedule, and where and how many times on each day in the order period 
to schedule it. 

Finally, an order will not schedule until it is approved by checking Approved, which can 
only be done by someone logged in with the Traffic Director password.  If you are 
not logged in with this password, then you cannot modify an order while it is 
approved. 
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Order Items 

 

To support sponsorships with billboards and multi-part spots that schedule in adjacent 
breaks, an Order Item allows you to schedule up to three Elements (tracks) per 
play of the item.  Most items, as in this example, consist of only one element.  In 
this case, Primary element doesn’t need to be set.  For each element you need to 
select a Track, Avail Type and Position. 

Track can be either an individual track or a spot packet.  If it’s a packet then the tracks 
in the packet will be rotated unless you set Primary element parts to 2 or 3 and 
you check the option Align parts with break.  If Primary element parts is set to 2 
and there are 2 tracks in the packet then for each break in which that the Order 
Item is scheduled Music 1 will schedule the first track in the packet first (not 
necessarily first position), and the second track in the packet next (not necessarily 
second position).  If Primary element parts is set to 3 and there are 3 tracks in the 
packet then the first track plays first, the second track next, and the third track after 
that. 

Avail Type restricts the element to play only in spot breaks with that Avail Type.  If you 
don’t use Avail Types, then just leave Avail Type blank. 

Position allows you to specify a required position or positions within the break for that 
element.  You can specify Any, First, Last, First or Last, or, if 
Primary element parts is 2 or 3, Book Ends.  Book Ends places the first part first 
in the break, and the last part last in the break.  Elements with Position Any will 
be placed in the order of longer to shorter, then higher production quality to lower 
production quality. 

Enter a Description only if you want some text other than the track (or folder) name to 
serve as the item description on your log and invoices. 

Charge is where you enter the charge per play of the item if the Billing Basis of the 
order is Charge Per Broadcast.  For any one of the package basis types Charge 
will say “PACKAGE” unless you have checked Bonus Spot–in which case Charge 
will say “FREE”.  A bonus item is a free item that Music 1 will always schedule after 
it has scheduled all non-bonus (pay) items on the order. 

Enter a Day Format only if you want this item to schedule only on logs created with 
that day format.  You would do this when the spot needs to play on days when 
some event is occurring. 
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If the spot is being paid for on a co-op basis, then select the co-op partner account for 
CoOp 1 and enter the % of the charge that this partner will pay. 

Check Schedule as filler only to use this spot to fill spot breaks that must be filled 
completely. 

Check Do not record bumps to tell Music 1 to treat the number of plays ordered for 
this spot as desirable but not absolutely required.  Use this to schedule non-paying 
spots like station promos.  The precise effects of this setting are described in the 
chapter on traffic scheduling. 

Spot Type is a selection of one of the spot types entered on the Rates tab of the 
Traffic Settings window.  Spot types are used to compute the charge per play 
when the Charge standard rates checkbox on the order is checked.  See the 
section on the Rates tab in the Traffic Settings window, below 

Multi-Element Order Items 

If you want to schedule spots in multiple, adjacent breaks for each play of an order 
item, then you need to set Elements to the number of such breaks.  If you set 
Elements to 2, 3, or 4 then you also need to set Primary element.  The Primary 
element is the main element.  The play time of that element is the time reported as 
the play time of the order item.  The primary element has the additional capability 
of playing multiple times in the primary break. (See Primary element parts, above.)  
The example below shows a sponsorship spot with an opener and a closer, for a 
total of 3 elements.  The primary, sponsorship break is the middle break so 
Primary element is set to 2.  In addition, three tracks from the packet “Chevy 
Folder” are specified to run in the sponsorship break. 
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Order Item Schedule 

 
 
On the Schedule tab you specify the hours in which play is allowed for the order item, and 

the number of plays ordered for the item on each day from Start Date through End 
Date.  The Hours Grid in the middle shows the schedule for the week that is selected 
in the bottom list, which is the list of all weeks from Start Date through End Date. 

On each day you can define up to four different sections of the day (A, B, C, and D) and 
specify the required number of plays in each section in the rows of boxes to the left of 
the hours grid.  In the example above the customer is ordering a total of 5 plays during 
morning and evening drive (6 AM→8 AM, 5 PM→7 PM), and 9 plays during all other 
hours between 9 AM and 10 PM.  The software doesn’t require you to define B, C or D 
hours if the total plays for the day can be specified with one number.  White hours are 
hours that the spot is not allowed to play.  
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To define the schedule for a week, do the following: 

1. Select a week in the weeks list at the bottom. 
 

2. Select some number of hours (possibly spanning more than one day) in the 
hours grid for the selected week.  You can select hours by clicking and dragging 
within the grid area, or clicking to select an hour then pressing the cursor up ↑ down 
↓ left ← or right → keys while holding down the Shift key on the keyboard.  For 
example, if you click in the upper left of the grid (Sun 12 AM) and drag to the lower 
right (Sat 11 PM) then you will have selected all hours on every day in the week.  

You can also select all the hours in a given day part by clicking  then clicking the 
desired day part from the menu. 

 

3. Once you have selected the hours you want, click    or  to mark the 

selected hours as A, B, C or D hours, or click  to mark the hours for no play.   
 

4. Type in the number of plays desired in each section of the day on each day in 
the week.  Tip: To speed entry, Music 1 will copy the plays you enter on any 
selected day (label having black background) to all other selected days.  Right after 
you select a range of days/hours in step 2 the set of days having hours you 
selected will be selected.  If you click again into the grid then only one day will be 
selected until you click-drag or select using the cursor up ↑ or down ↓.  To select all 
days Click and drag from Sun through Sat on any hour(s).  Then the plays you 
enter in the A, B, C or D column on any day will be copied to the same column on 
all other days. 

 
You can actually have a different schedule on every week (and therefore, on every day) 

from Start Date through End Date.  To save time, you can click Copy, select one or 
more weeks and click Paste to copy the weekly schedule currently being edited to all 
the selected weeks.  Or you can select the weeks first and every change you make to 
the weekly schedule will be copied to the selected weeks.  You can select every other 
week, every third week, every, fourth week, etc., by selecting some or all of the weeks, 
selecting the skip interval under Select Every, then clicking Select Every. 

At any time you can click Undo  or Redo  to undo or redo any change on the 
Schedule tab–including to the period plays, below. 

Specifying Plays Over Multiple Days 

You can choose to specify the number of plays on each individual Day as shown above, or 
specify the total per Week, Broadcast Week, 2 Weeks, 4 Weeks, Month, or 
Broadcast Month. By setting Period Type to the desired scheduling period.  When you 
set Period Type to a period other than Day you will see a list of all the scheduling 
periods of the selected size from Start Date through End Date showing the start day 
and end day and number of plays ordered for each period.  For period types other than 
Day you can only specify A and blank hours, and the number of plays entered for each 
day serves as a maximum allowable on that day.  (Rather than both the minimum and 
maximum as is the case for Day scheduling.) 
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In the example below, we are ordering 40 plays the first month, and 50 plays every month 
thereafter.  Play is allowed in every hour on every day except Sunday, and at most 2 
spots can play on any day. 

 
 
You may see that the hours in the grid that are gray (disabled) because they are on a day 

that is before Start Date or after End Date.  This is because the weekly schedule 
always shows a week from Sunday through Saturday (or Monday through Sunday for 
broadcast calendar) even if the schedule doesn’t start or end on those days.  So, 
define a weekly schedule to copy to other weeks, choose a week other than the first or 
last week so that all days on the Hours Grid are enabled. 

 

Order Templates 

Often you will sell the same or nearly the same package to many advertisers.  Music 1 
provides a simple way of reducing order entry time in those cases by allowing you to 
create an order template that can be customized with a particular customer’s data.  A 
template is just an order created via the menu File->Create New Template that is not 
associated with any account, and has no tracks selected on any of its items.  All other 
options on the Order and Order Item windows are entered just as for an order.  You 
are really just partially completing an order where the parts you are leaving out are the 
account and the track, or tracks, to be played.  To view the list of templates just click 
the View menu on the Orders window and check Order Templates: 
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To create a new template click File->Create New Template  

 
When the Order form appears, enter the Template Name, set all other fields as for a 

normal order, and add at least one item.  You will not be able to select a Track for any 
element on any item on the template. Just leave it (them) blank; it (they) will be filled in 
when you create an order from this template.  Fill in all other fields on each item as for 
a normal order item.  Save the item and the template. 

To use the template click File->Create New Order From Template from the Orders window. 

 

Select / fill out the fields in the order shown, click Create Order, and a new order for that 
Account will be created containing all the settings you filled in for the Template.  
When the Order window appears, complete or modify it as desired and open each item 
and select a Track for each element on each item. 
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Traffic Scheduling 

 
Music and traffic scheduling are performed from the same scheduling window on one 

music and traffic log (clock or list view).  Two sets of view buttons are central to 
controlling this: 

The Schedule View Buttons control the display of the schedule being edited.                     

 Displays the current hour of the schedule as a clock.  The clock view shows 
music, non-music and spot breaks.  The other views show spot breaks and spots in 
addition to music and non-music.                                                                                 

 Displays the current hour as a log.                                                                      

 Displays the whole day in one log.                                                                      

 Displays the whole day in one log along with the Breaks Chart, described 
below.   

The Item View Buttons control the kinds of items shown in the schedule area, the kind 
of item data shown below the schedule area, and whether traffic or music / non-

music items are scheduled by the Schedule button:                                                           

 Shows all items supported by the current schedule view, shows the 
Track Choices for the selected item, and enables scheduling of all non-traffic 

items.                        Shows only spot breaks and spots, displays the 
Spot Violations list, and enables scheduling of traffic. 
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 Shows only spot breaks and spots, displays the Active Orders list, and 
enables scheduling of traffic. 

 Shows statistics of the type selected by  (Hour Lengths or 
Native Content). 

 Shows the rotation chart (music / non-music track) or play history (spot or 
order item).  If you select a spot on the schedule, then the play history for just that 
spot is shown.  If you click on an order item, then the hours that are marked are 
ones where any spot from that order item is scheduled.  These differ when the item 
rotates spots. 

 To schedule spots all you need to do is click on either of the traffic views 
(Spot Violations or Active Orders), then click the Schedule button.  Music 1 will then 
schedule each of the items shown in the Active Orders list, in priority (Rank) order 
until all have scheduled completely or until it is unable to schedule all of the plays 
required for an item, which usually occurs because you have over-sold the day.  In 
the latter case, Music 1 will not attempt to schedule any more items after the first 
one that scheduled incompletely unless you lower the priority of (move down) the 
item that wouldn’t schedule completely, or Pre-Empt some plays of one or more 
items then click Schedule again.  Though very rarely needed, you can also 
schedule spots by hand using the Spot Violations list.  This allows you to schedule 
spots that violate scheduling rules.  The scheduler will not schedule a spot where it 
would violate a rule unless you have checked Allow over-filled breaks in the 
Traffic menu checked–in which case it will schedule an item in a break that would 
then be too long or have too many units only if it must do so to schedule the 
required number of plays for the item.  Manual scheduling and editing is rarely 
needed because music 1 automatically schedules spots wherever they can without 
violations, followed by many passes of automatic moving and swapping of spots to 
achieve the best separation.  Spots are moved to reduce the number of 
consecutive breaks or hours of play if you have enabled this on the Order window.  
All rules are enforced automatically including: 

Order Separation Music 1 calculates the minimum order separation based on the 
average number of plays per hour (Day scheduling), or the number of days left in 
the current scheduling period divided by the number of plays yet to be scheduled in 
this period (Week, Month, etc. scheduling).  So if an item is falling behind, Music 1 
automatically shrinks the required separation between items from the order. 

Product Separation Enter the minimum product separation on the Artists window. 

Announcer Separation You enter the minimum separation for announcers by clicking 
Edit Announcers from the Announcer Hours view of the Formats window. 

Same Hour previous day (Hr Prev Day) (if Music 1 determines restricting play in the 
same hour 2 or 3 consecutive days is achievable) 

Break Maximum Length as set on the Clock Item Properties window 

Break Maximum Units as set on the Clock Item Properties window 
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Position in the break if restricted on the order item window 

You can schedule music and traffic in any order or schedule only music or only traffic 
using the Item View buttons and the Schedule button.  As for music scheduling, 20 
levels of undo are available through the Edit menu or by clicking the Undo / Redo 

buttons:  

The Breaks Chart is a set of colored buttons that give you summary info about all breaks, 
or the currently selected spot organized by break.  The columns are hours (upper 
group are AM, lower are PM), and the buttons in each column are the breaks, in 
sequence, in that hour.  The drop-down list at the bottom of the chart selects the data 
shown in the chart. 

 

Spot Scheduled  

 Spot not scheduled here. 

 Spot scheduled here with no violations. 

 Spot scheduled here with only length / units violations. 

 Spot scheduled in this break with violations other than length / units. 

 Another spot on same order scheduled here with no violations. 

  Another spot on same order scheduled here with only length / units violations. 

 Another spot on same order scheduled here with violations other than length / 
units. 

Spot Passes 

 Break doesn’t match avail type, or isn’t in hours specified for the spot. 

 Spot can schedule with no violations here. 

 Spot would have only max length or max units violations in this break. 
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 Spot would have violations other than max length or max units in this break. 

Break Violations 

 No spots in this break have any violations there. 

 At least one spot here has length / units violations, but no other violations. 

 At least one spot here has violations more severe than max length or max units. 

 Click on a break in the chart to go to that break in the schedule. 

 Right-click, then click Move to start moving spot from that break.  Double-click on 
another break in the Breaks Chart or the Spot Violations list to move the spot there. 

 You can also move to other breaks using the keyboard cursor control keys. 

 

The Active Orders list is actually a list of the order items being scheduled today since it is 
the items on an order (not the order) that specify when and where the spots are 
scheduled. 

 

To view, an order item from the schedule right-click then click View order item.  Order 
items cannot be changed while scheduling. 

Rank The current scheduling priority of this item.  Music 1 automatically prioritizes items 
based on how difficult to schedule it is expected to be, how close today is to the end of 
the current scheduling period for the item, whether or not the item is a bonus spot, and 
the price.  You can change the priority of an item by selecting it and clicking these 
buttons under the list, or by holding down Ctrl and pressing cursor up / cursor 

down.  

Description The Description or Track title of the item followed by the Avail type name, if 
any. 

Bumps = <Plays ordered over previous 63 days> - <Plays scheduled in previous 63 
days>.  To schedule a bump, just select the item, click to the Break Violations view and 
double-click on any of the breaks shown in the Break Violations list.  To view the bump 
history (list of the plays short on each of the last 63 days), right-click on an item and click 
View bump history. 

Ordered = Number of plays ordered today when Period Type is Day or maximum plays 
allowed today when Period Type isn’t Day (e.g., Week, Month, etc.). 

Pre-Empt Enter number of plays to pre-empt (reduce the number ordered) for this item.  
You need to enter a number here only when you are over-sold and want to make room 
for a higher priority spot. 

Scheduled = Number of plays scheduled today only. 
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Short When Period Type is Day this equals Ordered – Scheduled.  When Period Type 
isn’t Day this equals <plays ordered through this day in current period> – <plays 
scheduled through this day in current period>, but never more than Ordered – 
Scheduled since Ordered is the maximum that can be scheduled today.  For example, 
if the item specifies 10 plays per week but no more than 2 plays per day and after 
scheduling Friday only 6 plays were scheduled, since the end of Friday is 6/7 of a 
week, 6/7 of 10 spots, or at least 8 spots, should have scheduled so the item is 2 plays 
behind for the week at this point. 

Elmts The number of elements on this order item. 

Position The position restriction for this item, if any. 

Length The average total length of the spots scheduled by this item.  This is takes into 
account the average length of spots in a packet (when rotating spots), as well as the 
length of the Track assigned to each secondary element (when an item has more than 1 
element).  Therefore, if you are rotating spots of different lengths, this number may not be 
a round :15, :30, :45, etc. 
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The Spot Violations list is a list of all breaks where the spots on the selected order item 
could be scheduled or moved (every break that has the Avail Type specified on the 
item, and that falls on an hour that is enabled for play on the Hours Grid of the 
Schedule tab of the Order Item window), with the violations that would occur if the spot 
were scheduled or moved there.  It does not include 

 
 

 If you select a spot in the log or select an item on the Active Orders list, The 
Spot Violations list will show the violations in all breaks where the item could be 
scheduled and the violations, if any, that would ensue if scheduled there.  To schedule 
the item in a break shown in the list, just double-click on the break. 

 If you right-click on a spot in the log or on a break on the Breaks Chart and click Move, 
this list will show all breaks where the spot could be moved and the violations, if any, 
that would ensue if moved there.  To move the spot to a break shown in the list, just 
double-click on the break. 

In either case the breaks listed are ones where the item is not currently scheduled and 
that have the Avail Type specified on the item, and fall on hours where the item is 
enabled for play as specified on the Hours Grid of the Schedule tab of the Order Item 
window.  (If the item has more than 1 element, than in addition, each secondary 
element must align with an adjacent break that matches the Avail Type of the element.) 

 Marks a break where the item would have no violations if scheduled or moved there. 

 Marks a break where the item would have violations if scheduled or moved there. 

  You can click on any of the column headings to sort the breaks listed by that field.  
Click again to sort in reverse.  If you sort by Violations, then Music 1 sorts the breaks 
by ranking the relative severity of the violations based on the rule priorities you select 
on the Rule Priorities tab of the Traffic Settings.  When sorting by violations, breaks 
that have the same violations are further sorted between them by Separation 
(separation between the break and the nearest break where the item is scheduled), 
longest to shortest.  A Separation is not shown when it is longer than 3 hours. 
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Traffic Settings Window 
Set the global traffic settings on this window, which you open via 

System >Traffic Settings. 

Types 

 
 
Here you can name up to 15 Avail Types. If all your avails can accept any spot then you 

don’t need these.  The second and third c=columns are for an abbreviation, and color 
which are there for future use. 

Account Types are used for grouping accounts in the Receivables Report window to 
allow totals to be printed by account type. 

Payment Types are just names for the various cash-equivalent payment types you can 
select from when entering a cash payment. 

Day Section Names Right now only the abbreviation in the second column of each of 
these is used to label each of the four sections of each day that you can order a 
different number of plays in on the Schedule tab of the Order Item window (p. 14) 

You can enter a name for each of the 5 Production Quality levels that you can assign to 
a Commercial Spot track.  Creating Spots (p.6) details the use of these in spot 
placement. 
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Personnel 

 
 

You can rename an account rep at any time, but you cannot delete a rep after you have 
scheduled spots from any order that this rep is assigned to, and charged them (p. 29). 

You need to enter a Password for Traffic Director to be able to approve orders (allowing 
them to schedule), enter payments or adjustments.  Use a password that you will 
remember as there is no automatic password recovery in the program as of 7.0.61. 

The Name you enter for Affidavit signer will be printer just under the signature box on the 
affidavit portion of an invoice. 
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Rule Priorities 

Here you set the relative ranking of each traffic rule violation except “Hr Prev Day” (same 
hour 2 or 3 consecutive days), which always the  higest priority since it excludes a spot 
from scheduling where it occurs.  Priorities are listed in highest to lowest order where 
highest means most severe. 

 
 
You can separately set the relative ranking of the two sets of rule violations below, but you 

cannot move a violation from one set to another since Music 1 handles and displays 
size violations differently than non-size violations: 

Non-Size Violations 
Order Separation 
Product Separation 
Announcer Separation 
Position Within Break (cannot achieve required position within break) 
Plays Same Hour (two or more plays the same hour) 
Consecutive Hours or Breaks (too many Consecutive hours or breaks 
with spots scheduled from same order) 

 
Size Violations 

Break Maximum Units (there are more than Max Units spots in the break) 
Break Maximum Length (the break is longer than Maximum Length) 
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Standard Charges Table 

 
In the upper list you can name up to 12 different Spot Types and for each type enter the 

maximum length of each of up to 16 spot length classes.  In the example above, the 
first class for Commercials is for spots from 0- 15 seconds long.  The second class is 
for spots from 16 to 30 seconds long, etc.  Make sure the max length of the last class 
is large enough to include the longest spot you plan to schedule of that Spot Type. 

In the lower list you enter the charge for each length class and each day part, that is the 
price for 1 play in the Day Part shown on the left of a spot of the type selected in the 
upper list, whose length is within the bounds shown in the column header.  To speed 
data entry you can click Copy Day Part, click to any other day part, then click 
Paste Day Part to copy all the rates, class-by-class, from the first day part to the 
second, third day part, etc.  You can opt to Interpolate the charge for a spot that is 
longer than the minimum length allowed in the length class it falls within.  In the 
example above, a 20 second spot would be charged 75.00 + (100.00 -75.00) X (20-16) 
/ (31-16), or 81.67. 
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Billing Defaults 

 

 
 

All these defaults, except Commissions due only after invoice paid and Trade Credit 
are copied to the Order Defaults tab of every new account created.  The defaults on the 
Order Defaults tab of an account are copied to every new order created for the account. 
The default Trade Credit set here is the default trade credit setting for every new order.  If 
you check Commissions due only after invoice paid, then a payable will not be 
generated for either an agency commission or an account rep commission for an invoice 
until the invoice is completely paid.  For an explanation of the financing settings see the 
chapter on billing. 
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Billing 

Applying Charges for Scheduled Spots 

 
 

Before charges for spots scheduled in a log will show up on invoices, you must select the 
log on the Logs window click the Charge Schedule button.  Once you have charged a 
log you cannot edit or delete it. 
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Invoices 

 

The Invoices list on the Billing form lets you view invoices having the status you select with 
the Status list on the left, either… 

Ready invoices are invoices that have not yet been issued, but are ready to be 
issued. 

Final invoices are invoices that have been issued. 

Pending invoices are invoices not yet been issued and are not ready to be issued. 

An invoice is ready to be issued for an order when you have scheduled and charged logs 
through the end date of the next Billing Period that ends after the issue date of the 
last invoice for that order (where Billing Period is that selected for the order).  For 
example, if Billing Period for an order is Month and you last issued an invoice Sep 28, 
then once you schedule and charge logs through Sep 30 a new invoice will be ready 
for Sep 30 that will have a Start Date of Sep 29 and an End Date of Sep 30.  Once you 
issue that invoice, though, another invoice will not be ready until the end of the next 
month (Oct 31).  As shown in this example, you may issue an invoice at any time, even 
if it isn’t ready by issuing it from the list of Pending invoices. 

To issue an invoice, select it then click the Print button.  When you click Print the first time 
for an invoice it is formally issued (entered into the database), then printed.  Clicking 
Print again for an invoice merely prints it.  When you issue an invoice it will disappear 
from the list of Ready or Pending invoices and can only be seen in the list of Final 
invoices or in the Receivables list. 
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Invoice is the automatically generated ID number of the invoice. 

Description is the Product of the order that generated the invoice. 

End Date is the date that the invoice was issued, and the last log date whose charges are 
included in the invoice.  The first log date whose charges are included in the invoice 
(the Start Date) is either the Start Date of the order (for the first invoice for the order), 
or one day after the End Date of the previous invoice for the order. 

Ordered shows how many plays were ordered between all items on the order over the 
period from Start Date through End Date.  Played shows the number of actual such 
plays over the same period.  + / - shows Played – Ordered and is red if Played < 
Ordered, green if Played > Ordered, and blank if they are the same. 

Charges is the total log charges period from Start Date through End Date from the order 
that generated the invoice. 

Adjustments is the total of all adjustments made directly to the invoice as a result of 
editing the invoice. 

Payments is the total of all payments to the invoice– always shown as a negative value. 

Balance Due is the sum of Charges+ Adjustments+ Payments. 

You can sort the invoices by any one of these fields by clicking on the column header.  
Click a second time on the same header to sort in reverse order. 

Details of the selected invoice are shown at the bottom. Credits to cash and 
Credits to trade are the amounts credited to cash / trade after a paid invoice was 
reduced in value after being edited.  See Editing an Invoice, below. 

CoOp Invoices 

If the account placing an order has a co-op partner then you may view the invoice items 
for the primary account, or the cop-op account(s) by selecting the account in the drop-
down list above the invoice totals on the right.  An additional column “Share” is shown 
in the items list indicating what share of that item’s Amount that account is responsible 
for.  The Amount x Share is shown in Net. 
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Printing Invoices 

Here is a printout of invoice 0041.  The RGTSIZ4658WT in Invoice ID is the Invoice PO 
entered for the order. The number 0041 is the automatically generated. 

 
 
On the Data tab of the Invoice window you select the kind of detail to include in the 

printout with the Type and Affidavit fields.  Affidavit selects whether the affidavit 
shown at the bottom of this printout is printed for the primary, and co-op account of the 
order.  On a co-op order there is a separate printout for each account.  The Type field 
selects the amount of detail in the invoice.  The options for this are: 

Order Total Plays, Length Only the totals information shown in the header above is 
printed. 

Per Item Plays The plays and charge of individual items on the order on each day 
are listed as shown above. 

Per Item Plays, Length Individual items are listed as above with the addition of 
another column Length showing the total length of the spots from that item that 
aired on the day corresponding to that line. 

Per Item Plays, Times Like the printout above except that the air times on each day 
are listed (usually in smaller, bold font) right under the description on each day 
listed.   

Per Item Plays, Times, Length Like Per Item Plays, Times, except that a Length 
column is added showing the total length of the spots from that item that aired on 
the day corresponding to that line. 
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Receivables 

 
The Receivables list shows all invoices that have been issued and have a positive 

balance as of the selected date (that defaults to today).  Once an invoice is fully paid it 
disappears from the Receivables list. 

Statements 

 

To view statements, click on the Statements tab of Billing.  To filter the set of accounts 
listed, select, in any order from top left, Account Type, Revenue Type, Account Rep, 
From Date and Through Date.  Through Date isn’t necessarily today.  Click on any 
column header to sort by that field.  Click again to sort in reverse order.  The full 
statement for the selected account is shown at the bottom.  Here, the Right Size 
account is shown before any adjustments or payments, or invoice edits. 
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Entering Adjustments 

To enter a new adjustment to the selected account, select the item you wish to adjust in 
the statement items list at the bottom and click Adjust.  For example, to adjust the 
interest on invoice 41, select the second statement item (“0041-IN”) and click Adjust.  
That will bring up the Create Adjustment window.  To delete an adjustment, just select 
it and click the Delete button. 

 

 

The image below shows the statement the next day after the “Adjust interest and cancel 
future interest” adjustment of $100.00 was entered.  The account has not and will not 
incur any additional interest after this adjustment on 26 Dec 2010. 
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 Entering Payments 

 
Cash and Trade payments, pre-payments and payments from customer’s credit balance 

are all entered through the same payment window, which you can reach any of these 
ways from the Billing window: 

1. Select a receivable in the Receivables list then click Pay selected receivable. 
2. Select a payable in the Payables list then click Pay selected payable. 
3. On the Payments tab select an account to Collect payments for then click 

New Payment. 
4. Click the Pay button shown on the left of the statement items list. 

If you want to select a different Account to record a payment for, then do that first. 

If the account is an agency, then you will need to set the payment Direction.  Otherwise, 
Music 1 will set the direction: Received for an advertiser, or Sent for an account rep.  
Then set Revenue Type to: 

Trade for payment of allowable trade portion of invoices of trade orders, or 
Cash for payment of residual portion of invoices trade orders (after zero or more of the 

trade portion has been paid by trade), invoices of cash orders, finance charges, and 
commissions. 

 If the account has a credit balance in the selected Revenue Type then Music 1 will check 
Pay from credit balance and set Amount to that balance.  This allows you to pay 
invoices with an account’s credit balance.  If you do not want to pay from credit 
balance, then un-check Pay from credit balance and enter an Amount.  Or, if there is 
no credit balance, enter an Amount. 

Date, the effective date of the payment, defaults to today, though you can change it. 

Pay Details is for any descriptive info (check number, credit card number, etc.). 

The balances on this window are computed as follows: 

On each item Balance = Due – Applied 

Amount not applied = Amount – <sum of Applied for each item shown >. 

Account Balance = <sum of Balance for each item shown>. 

To actually pay something you need to either click Auto Apply or enter an amount into the 
Applied column for one or more of the items then click Save Payment. 
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Recording a Trade Payment 
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When paying via Trade the column Max Trade shows the maximum portion of the 
charges still Due for an invoice that can be paid via trade.  It equals the Minimum of Due 
and Trade_Credit (For Trade_Credit Fixed), or minimum of Due and Invoice_Charges X 
Trade_Credit / 100 (For Trade_Credit Percent).  In this example, Trade Credit  = 60%. 

Invoices of cash orders, finance charges and commissions are not listed (not payable) 
when paying by trade, and you can enter an Applied value only up to Max Trade on 
each trade invoice shown.  Since Balance = Due – Applied, the portion of the charges 
Due that are not paid by trade will be reflected in Balance, and must be paid later by 
some combination of cash and trade.  In this example, $1,960.00 from invoice 0041 
remains payable. 

Recording a Cash Payment 

 
Set Revenue Type to Cash for recording any non-trade payment type (cash, check, credit 

card, cashier’s check, PayPal, etc.) that you name on the Types tab of the 
Traffic Settings.  If Pay from credit balance is not checked, then you will need to 
select a Payment Type and enter an Amount.  In this example we are paying the 
$1,960.00 remaining payable on invoice 41 after the $2,940.00 trade payment,  
$274.34 of interest on invoice 0041, and $250.00 of late fee on invoice 0041.  These 
items add up to $2,484.34 so the $15.66 of the $2,500.00 payment that remains not 
applied will be added to the account’s cash credit balance.  (Credits are applied the 
same way to trade balance for trade over-payments.) 

When you click Save Payment, Amount not applied is added to the account’s 
cash or trade credit balance (whichever Revenue Type is selected).  This balance can 
be used later to make payments.   To enter a pre-payment, don’t click Auto Apply or 
anything into Applied and click Save Payment.  The full amount will then be credited 
to the account’s cash / trade credit balance. 
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The image on the next page shows a statement for Right Size after both payments in this 
payments example have been entered. 

 

Editing an Invoice 

If you realized after an invoice was issued that some spots didn’t actually air, or you want 
to adjust the total on the invoice for any other reason, then click the Edit button above 
the Invoices list.  In this window you can correct the actual number of plays on any day 
in the Corrected Plays column.  Music 1 will then compute the corrected charges on 
that day and show them under Corrected Amt.  However, you can do this only if the 
order that generated the invoice is not billed on a Charge Per Broadcast basis with 
Charge standard rates checked.  Otherwise, the spot may have a different charge in 
different day parts, so computing the new charges cannot be done from the total plays. 

At the bottom-right you can enter a positive or negative adjustment in the amount charged. 

 

You can edit an invoice even after it has been partially or completely paid.  If the invoice 
balance after the edit is less than the original charges, and the invoice has been 
partially or completely paid, then Music 1 will credit the resulting overpayment, if any, 
back to the Cash credit balance or Trade credit balance of the account.  These 
balances can be used to pay other invoices as described under Entering Payments. 
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In this example we have reduced the plays on 5/15 from 6 to 5.  Since this spot is charged 
at $100.00 per play, the corrected amount is now $4,800.00 instead of $4,900.00. 

 

Since the invoice was fully paid by the time it was reduced by $100, all of the $100 
becomes a credit to the customer’s cash and / or trade credit accounts.  In this case, 
Music 1 was able to make up the full $100 credit by crediting $100 to the customer’s 
cash credit balance (since a cash payment of at least $100 was made to the invoice). 

 

The next image shows the Right Size invoice 0041 after it was reduced in value from 
$4,900.00 to $4,800.00 on Dec 28. 

 

The next image shows the Right Size statement for 28 Dec after invoice 0041 was 
reduced in value from $4,900.00 to $4,800.00 on Dec 28. 

 

 


